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SAMURAI for NinjaTrader® 

Risk Disclosure Statement 
 

The risk of loss in trading commodity futures contracts can be substantial. You should 

therefore carefully consider whether such trading is suitable for you in light of your financial 

condition. You may sustain a total loss of the initial margin funds and any additional funds 

that you deposit with your broker to establish or maintain a position in the commodity futures 

market. Past performance is not indicative of future results. We recommend that you learn 

more from the Commodity Futures Trading Commission (CFTC) or the National Futures 

Association. 

 

Trading Securities: 

In considering whether to trade in securities or enter into any such transaction, you should be 

aware that trading in securities can be extremely risky. You should be prepared to lose all of 

the funds used for trading in securities. You should not fund your security trading activities 

with retirement savings, emergency funds or funds set aside for purposes such as education or 

home ownership. Trading in securities can also lead to large and immediate financial losses. 

Trading in securities requires knowledge of the securities markets. Trading in securities 

requires in-depth knowledge of the securities markets and trading techniques and strategies. 

In attempting to profit through trading in securities, you must compete with professional, 

licensed traders employed by securities companies. You should have the appropriate 

experience before engaging in the trading of securities. All losses are your responsibility. 

 

Hypothetical Risk Disclosure Statement: 

 

"Hypothetical performance results have many inherent limitations, some of which are 

described below. No representation is being made that any account will or is likely to achieve 

profits or losses similar to those shown. In fact, there are frequently sharp differences 

between hypothetical performance results and the actual results subsequently achieved by any 

particular trading program. 

 

One of the limitations of hypothetical performance results is that they are generally prepared 

with the benefit of hindsight. In addition, hypothetical trading does not involve financial risk, 

and no hypothetical trading record can completely account for the impact of financial risk in 

actual trading. For example, the ability to withstand losses or to adhere to a particular trading 

program in spite of trading losses are material points which can also adversely affect actual 

trading results. There are numerous other factors related to the markets in general or to the 

implementation of any specific trading program which cannot be fully accounted for in the 

preparation of hypothetical performance results and all of which can adversely affect actual 

trading results." 
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We offer a simple and powerful collection of improved technical indicators inherited from 

classical oscillators widely used throughout modern technical analysis. These oscillators take 

advantage of full intra-bar information provided by the NinjaTrader® charting package. They 

allow for up to four times better precision against their classical counterparts. Samurai 

indicators also offer a special benefit to high-frequency intraday trading, because they 

provide far greater accuracy on short period price oscillations. 

 

Introduction 
 

Standard price bars on a chart typically have four channels: open, high, low and close. Many 

technical indicators use only one of these channels for statistical analysis. In figure 1, we 

illustrate the benefits of using all four channels to improve trade signal precision. This is 

illustrated in a simple example of the Bollinger Bands indicator listed below. 

 

 
 

Figure 1: Probability Channel with Improved Bollinger Band 

 

Figure 1, illustrates a simulated intra-bar probability channel associated with the price 

components provided on the chart. The blue price gradient depicts the associated probability 

levels extrapolated from the price sample within each bar. Against this price distribution, we 

plot Bollinger bands calculated by the standard method against the improved price bar 

resolution. One can see that the bands using all of the available price information are 

smoother and more consistent with the price channel. In Samurai, we include the indicators in 

figure 1, as well as many other indicators using the same improvement principle. 
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SAMURAI for NinjaTrader® 

Background (The Mystery of Market Prices) 

 

 
 
Samurai is actually based on quantum physics theory. Specifically, the quantum uncertainty 

principle.  

 

Quantum uncertainty of price is the acknowledgment that uncertainty affects the 

measurement of market conditions in the same fashion that uncertainty affects quantum 

systems. This suggests that all known price points should be used to leverage uncertainty. For 

this reason, Samurai takes advantage of all four price channels simultaneously. A visual 

representation of this principle is depicted in figure 2. For those that are interested in the 

details, please read the article, “Unraveling the Mystery of Stock Prices” (Zinchenko, 2010). 

 

 
Figure 2: Leverage Uncertainty 
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Stable Price Aggregates 
 

To decrease the amount of information to deliver, data providers commonly use a sort of 

price aggregation. The standard aggregation approach has evolved historically. It includes the 

classical combination of open, high, low, and close prices for a symbol over a given period. 

Occasionally extra fields such as volume, open interest, and other quantities are also 

provided. 

 

On a typical time stamp from a data vendor, this aggregate will generally be written into one 

line as follows: 

 

Date Open High Low Close 

2000.01.01 00:00:00 4.12 5.18 3.14 4.72 

 

It is evident from the first glance that the data is incomplete. All four points are voluntarily 

assigned to one common time stamp, despite different events and time intervals. A more 

accurate table would look something like this: 

  

Date Open High Low Close 

2000.01.01 00:00:00 4.12    

2000.01.01 00:00:01   3.14  

2000.01.01 00:00:02  5.18   

2000.01.01 00:00:03    4.72 

 

Therefore, we must come to the conclusion that nearly all financial data (and indicators that 

use them) is delivered to traders in an arbitrarily tampered and malformed fashion. For a 

novice, the difference may appear hardly noticeable. However, the impact of this hidden 

knowledge becomes crucial in real-time analysis. When the exact time of a trade signal can 

spell the difference winning or losing, you want the most accurate data possible. 

 

 
Figure 3: OHLC Price Bar as Scatter Diagram 

 

One can only wonder why such poor data aggregation has been established as the dominant 

norm of data vendors. Data provided for a given timestamp represents a random set of four 
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points over a period that does not correspond to the timestamp indicated. As plainly evident 

in figure 3, a typical trading bar is an attempt to package a scatter diagram of four prices 

observed over one given period. A continuous chart built on such data offers unstable visual 

impressions and false trend indicators.  

 

One way to improve precision without acquiring additional data is to use all of the available 

data from the provider and smooth that data. In Samurai, we take all four data points lumped 

under one time stamp and sum up the averages over several bars. Not only will you have four 

times the amount of data, but the relative role of high and low prices in the average will 

steadily diminish.  

 

Installation 
 

The Samurai indicators are easily installed in a fashion similar to other NinjaTrader® 

indicators. Here is the installation process: 

 

1. NinjaTrader ships as a 32 and 64 bit version in a single package 

2. If you have 64 bit Windows, both 32 and 64 bit are installed 

3. Samurai can only be installed on 32 or 64 bit  

4. Always run the NinjaTrader bit version matching the Samurai version 

5. If you already have a previous version of  Samurai installed, remove it first: Control 

Center > File > Utilities > Remove NinjaScript Assembly 

6. NinjaTrader package setup: 

 Run proper version of NinjaTrader 

 Save NinjaScript of Samurai in convenient location 

Example of file name: SamuraiSuite_8_2019_05_09.zip 

 Import NinjaScript: Control Center > File > Utilities > Import 

NinjaScript (point to your convenient location) 

 Get NinjaTrader Machine ID: Control Center > Help > About 

 Send activation request mail with NinjaTrader Machine ID to 

support@quant-trade.com 

 

Indicator Overview 
 

Once installed, you will have a series of new indicators that are preceded by 

an identifier called, “Precision”. Each indicator is an improved version of its 

counterpart. In the following table, we briefly describe each indicator as 

compared to its classic counterpart included in the NinjaTrader platform. 

We have also included several new indicators that are explained in the 

“Price Beam” section below. 

 

Indicator Counterpart Comment 

Precise APZ Adaptive Price Zone 

(APZ) 

The adaptive price zone (APZ) is a 

volatility-based indicator that helps 

investors identify possible market 

turning points. 

mailto:support@quant-trade.com
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Precise Average Average Price Average of a series of prices from the 

chart. Precise Average uses all price 

channels. 

Precise Bollinger 

Bands 

Bollinger Bands Uses “Precise Standard Deviation” 

and “Precise Average” for better 

precision as displayed in figure 1. 

Precise DEMA Double Exponential 

Moving Average 

(DEMA) 

The (DEMA) uses two exponential 

moving averages (EMAs) to 

eliminate lag, as some traders view 

lag as a problem. The (DEMA) is 

used in a similar way to traditional 

moving averages (MA). 

Precise DM Index Directional Movement  

Index (DMI) 

The Directional Movement Index, or 

(DMI), is an indicator developed by 

J. Welles Wilder in 1978 that 

identifies in which direction the price 

of an asset is moving. The indicator 

does this by comparing prior highs 

and lows. 

Precise EMA Exponential Moving 

Average (EMA) 

The (EMA) is a moving average that 

places a greater weight and 

significance on the most recent data 

points. 

Precise FOSC  Forecast Oscillator 

(FOSC) 

The Forecast Oscillator is a technical 

indicator that compares a security 

closing price to its time series 

forecast. Uses “Precise Linear 

Regression” as the forecast base. 

Precise HMA Hull Moving Average 

(HMA) 

The Hull Moving Average (HMA) 

was developed by Alan Hull for the 

purpose of reducing lag, increasing 

responsiveness while at the same time 

eliminating noise. 

Precise Linear 

Regression  

Linear Regression Extension of the linear regression 

based indicators. Calculated on all 

price channels to improve the 

precision.  

Precise Linear 

Regression Intercept 

Linear Regression 

Intercept  

This linear regression intercept 

indicator plots the intercept for the 

trendline for each data point. It is 

calculated on all price channels. 

Precise Linear 

Regression Slope 

Linear Regression Slope This linear regression indicator plots 

the slope of the trendline value for 
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each given data point. It is calculated 

on all price channels. 

Precise MA Envelopes  Moving Average 

Envelopes (MA 

Envelopes) 

Envelopes are technical indicators 

that are typically plotted over a price 

chart with upper and lower bounds. 

The most common example of an 

envelope is a moving average 

envelope. 

Precise MACD  Moving Average 

Convergence/Divergence 

(MACD) 

The (MACD) turns two trend-

following indicators, moving 

averages, into a momentum oscillator 

by subtracting the longer moving 

average from the shorter one. 

Precise Momentum Momentum The Momentum Indicator (MOM) is 

a leading indicator measuring a 

security's rate-of-change. 

Precise PPO Percentage Price 

Oscillator (PPO) 

The Percentage Price Oscillator 

(PPO) is a technical momentum 

indicator that shows the relationship 

between two moving averages in 

percentage terms. 

Precise Price 

Oscillator  

Price Oscillator The Price Oscillator (PO) is a 

technical momentum indicator that 

shows the relationship between two 

moving averages 

Precise ROC Rate-of-Change (ROC) The Rate of Change Indicator (ROC) 

is a momentum oscillator, which 

measures the percentage change 

between the current price and a given 

period past price. 

Precise RSI Relative Strength Index 

(RSI) 

The Relative Strength Index (RSI) is 

a well-versed momentum based 

oscillator which is used to measure 

the speed (velocity) as well as the 

change (magnitude) of directional 

price movements. 

Precise SMA Standard Moving 

Average (SMA) 

Standard Moving Average (SMA) 

calculated on all price channels. 

Precise Standard 

Deviation 

Standard Deviation Standard Deviation calculated on all 

price channels. 

Precise Standard Error Standard Error Standard Error calculates the error 

between prices and a linear regression 
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line. Uses Precise Linear Regression 

to calculate with all price channels. 

Precise TEMA Triple Exponential 

Moving Average 

(TEMA) 

Designed to smooth price 

fluctuations, thereby making it easier 

to identify trends without the lag. 

Uses “Precise Exponential Moving 

Average”. 

Precise TMA Triangular Moving 

Average (TMA) 

The (TMA) is similar to other 

moving averages. However, the 

triangular moving average differs in 

that it is double smoothed. Calculated 

on all price channels. 

Precise TRIX Triple Exponential 

Average (TRIX) 

Displays the percentage Rate of 

Change (ROC) of a triple (EMA) 

over all of the price channels. 

Precise TSF Time Series Forecast 

(TSF) 

Calculates probable future values for 

the price by fitting a linear regression 

line over a given number of price bars 

and following that line forward into 

the future. Uses all price channels. 

Precise WMA Weighted Moving 

Average (WMA) 

The average value of a security's 

price over a period of time with 

special emphasis on the more recent 

portions of the time period. Uses all 

price channels. 

Price Beam No Counterpart See below for detailed description. 

Price Beam Linear No Counterpart See below for detailed description. 

   

 

 

Price Beam Indicators 
 

The Price Beam is the fundamental indicator that constitutes the core foundation of the other 

indicators in Samurai. It visually displays the stochastic distribution of the underlying price 

points in the form of a visual heat map. Higher regions of color intensity reveal a greater 

concentration of the price probability function, while less color intensity corresponds to less 

likely price distribution ranges. No color designates an outer field of zero probability for 

price distribution. Brightly colored regions represent channels of higher probability ranges. 

Figure 4 is a graphical representation of a price chart with multiple price distribution 

channels. Each channel has a different associated level of probability. Collectively they have 

a price distribution range.  
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Figure 4. Price Distribution Channels 

There are two types of Price Beam indicators. One is simply called the Price Beam and the 

other is the Price Beam Linear. The Price Beam depicts color intensity according to the 

Gaussian probability of decay from the median value in the price channel. Essentially this 

means that the normal Price Beam is more exact, but not as easy to see visually. The Price 

Beam Linear depicts the same decay, but according to a simple linear decay function. This 

makes ‘Linear' better for visual perception, but less exact with respect to the true probability 

level. Specifically, it relates to a rule, which is used for coloring different levels of 

probability. 

An example of how the four prices are distributed across price channels is represented as a 

Gaussian probability of decay and represented in figure 5. Here you see what looks like a 

Bell curve with three standard deviations from the mean. Each deviation level is composed of 

all four prices in each bar. This demonstrates the likelihood of price-concentration and price 

decay on the chart. The actual calculations in the Price Beam are somewhat more 

complicated, but this example should give you a general idea of how it works. 

 

Figure 5: Price Probability Channels 
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Examples of the Price Beam and the Price Beam Linear are presented in the screenshots 

below. Both of these indicators can be used to forecast the range of each bar and the 

likelihood of that range. The brighter areas of the beam correlate with standard deviation and 

Gaussian probability channels. This suggests that most price activity will fall in the higher 

intensity areas of the beam.  

In figure 6, a Price Beam is added to a chart in NinjaTrader®. You can see the fine resolution 

of the Price Beam and the highest probability channels. 

 

 
 

Figure 6: Price Beam 

 

In figure 7, the Price Beam Linear is placed on the same chart. While the range is not as 

specific, this view gives you a wider range of possibilities. Used together, the Price Beam and 

Price Beam Linear can maximize their potential. 

 

 
 

Figure 7: Price Beam Linear 



 

 

 

12 | P a g e  

 

SAMURAI for NinjaTrader® 

Summary 
 

The data dilemma explained in this guide severely complicates price forecasting. If we only 

take the open or close price as a forecasting base for a trading strategy, then we rely on a 

partial portion of statistical information during marginal market periods. This open or close 

data may not represent the market state inside that period. If, on the other hand, we take the 

high or low period as a forecasting base, then we have the advantage of the precise value 

range, but not the time accuracy. Combined together, these factors predetermine forecasting 

error at least equal to the size of the bar aggregation quadrant depicted in figure 3. 

 

We can decrease the error by using complete price data (OHLC) and forecasting with all four 

price components. In this case, the associated trading signal precision will increase up to four 

times against the original. While the real boost can be considerably less due to the time 

uncertainty of high and low values, it is still a valid improvement. Based on this 

interpretation, we offer a number of simple chart analysis techniques, which are expected to 

improve the accuracy of trade signals based on quantum mechanics. 
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